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BAI 1. CAI PAT VA LAM QUEN VOI UBUNTU - CENTOS - HAI BAN PHAN
PHOI CUA LINUX

< UBUNTU:
Ban phat hanh dau tién ctia Ubuntu 1a vao 20 thang 10 nam 2004.

Ubuntu luén phat hanh dudi 2 dang va luén co6 ban cho server va desktop:
- Phién ban thong thudng: Phat hanh 6 thang 1 1an, ban méi nhat 1a Ubuntu 15.10
- Phién ban hd tro 1au dai (Long Term Support): Phat hanh 2 nim 1 14n, ban méi nhat
la Ubuntu 16.04.4 LTS

Ubuntu thudng thich hop véi viéc lam quen véi méi truong Linux — hé thong giao dién gan
gilii voi moi truong Windows desktop

Download phién ban méi nhéat cia Ubuntu trén trang www.ubuntu.com
Download phién ban mdéi nhat cia VMware Workstation trén  trang
https://my.vmware.com/web/vmware/downloads/

VMware Workstation 12 mot phan mém ao héa desktop manh mé& danh cho cac nha phat
trién/kiém tra phan mém va cac chuyén gia IT can cha y nhiéu HDH moét luc trén mot may
PC. Nguoi dung c6 thé cha y cac HDH Windows, Linux, Netware hay Solaris x86 trén cac
may ao di dong ma khong can phai khdi dong lai hay phan ving 6 cin

Phién ban str dung cho cac bai thyc hanh:

Ubuntu Desktop 16.04
http://releases.ubuntu.com/16.04/ubuntu-16.04-desktop-i386.iso
VMware Workstation 12
https://my.vmware.com/web/vmware/downloads/

< CENTOS
CentOS 7
https://www.centos.org/

Link download CentOS 71386 15.11
http://mirror.centos.org/altarch/7/isos/i386/CentOS-7-i386-Minimal-1511.iso

Phat hanh phién ban dau tién vao ngay 14 thang 5 nam 2004 va nguoi sang lap ra CentOS
la Lance Davis.

Hé diéu hanh CentOS 1a mot ban phan phdi Linux dugc cung cdp mién phi dé phuc vu cho
cac may chu. CentOS duoc xdy dung tr nguén cuaRed Hat Enterprise
Linux (RHEL), ciing giong nhu Ubuntu dugc xay dung tir ngudn Debian.

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS


http://www.ubuntu.com/
https://www.virtualbox.org/
https://www.virtualbox.org/
https://www.centos.org/
http://mirror.centos.org/altarch/7/isos/i386/CentOS-7-i386-Minimal-1511.iso
https://en.wikipedia.org/wiki/Red_Hat_Enterprise_Linux
https://en.wikipedia.org/wiki/Red_Hat_Enterprise_Linux
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Ciing nhu cac ban phan phdi Linux khac, CentOS dugc st dung chi yéu cho ‘cac may chu
va cling chi nén st dung no dé phuc vu cho mot may chi. Nhung trong mét sb truong hop,
néu can chay cic ung dung nhu duyét web, soan thao van ban... thi c6 the st dung mot
moi truong Desktop. Pé c6 mot méi trudng Desktop trén CentOS, can phai cai dit
GNOME hoac KDE cho CentOS.

C6 nhiéu ban CentOS c6 thé lga chon do 1a DVD ISO, Everything ISO, Netlnstall ISO,
LiveGNOME ISO, LiveKDE ISO, LiveCD ISO va Minimal 1SO.

- DVD ISO la ban dugc bao gdm tit ca cac goi ung dung co thé duoc cai dit thong
qua trinh cai dat. Ban nay dugc khuyen nghi cho tat ca nguoi ding.

- Everything ISO la ban chira day du tat ca cac goi tng dung cho CentOS 7. Néu sir
dung ban nay thi ban can burn ra 2 dia DVD hodc mot USB 8Gb. Ban nay nhiéu go1
ung dung du thira qua nén khong nén dung.

- NetInstall ISO 1a ban ma cac géi ing dung s& duoc 1y tir mang va cai dat. Ban nay
can mot mang internet.

- LiveGNOME ISO va LiveKDE ISO 13 ban ma ban c6 thé str dung thir CentOS thong
qua DVD hoic USB ma khong can cai dit.

- LiveCD la ban giéng nhu LiveGNOME ISO nhung khong c6 cic goi ing dung nhu
LibreOffice.

- Minimal ISO 1a ban chi c6 nhiing g6i ing dung can thiét t6i thiéu dé c6 mot hé
thong CentOS. Néu can cai thém ung dung thi phai str dung 1énh dé cai thu cong.
Ban nay phu hop dé dung 1am server.

No6i dung bai thuc hanh sé stt dung ban Minimal

LUU ¥: TAT CA SINH VIEN TAO 1 THU MUC TEN : JiS8¥ CUA CHINH SINH
VIEN PO VA LUU VAO O , TAT CA MOI FILE THU'C HANH PEU
PHAI LUU VAO THU MUC NAY

PHAN 1: CAI PAT VA LAM QUEN UBUNTU
A. Cai @it Ubuntu

< Buéc 1: Khéi dong phan mém may a0 VMware

- Sau khi khé1 dong VMware nhu hinh sau

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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| File Edit View VM Tabs Help f
P2 o O)axg|o
Library X & Home X}

| Q, Type hereto search - ‘

=l My Computer

2 s VMware” Workstation 9

Create a New Virtual Machine
Create a virtual machine on this computer,

Virtual Network Editor

Change the network configuration used by
virtual machines on this computer.

1@

) = Open a Virtual Machine e, = Workstation Preferences

RN —=

Open a virtual machine en this computer, A Custemize VMware Workstation to your way
- of working.

Connect to a Remote Server f . Software Updates

Open virtual machines on a remote server. | | Check for software updates for Vivware

\\ / Workstation.
Virtualize a Physical Machine f . Help
= (Create a virtual machine from an existing | | View the help topics for ViMware
physical machine. \\ / Workstation.

% Buwdrc 2: Cai dat Ubuntu desktop 16.04 LTS trén may ao VMware

Trén man hinh chinh VMware chon File ->New Virtual Machine Nhan Next

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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1) VMware Workstation

File Edit View VM Tabs Help

P - | © © m\l@‘gx 5 | O
Library = — ‘
{ Q Type here to search 'W {

il My Computer

ared VMs & [ New Virtual Machine Wizard ==
B VMware” W0 mmm——

Welcome to the New Virtual
Machine Wizard

Creaty
Create| \fration used by
What type of configuration do you want? ‘fputer.
@ Typical (recommended)
Openf Create a Workstation 9.0 virtual machine
Openg in a few easy steps. | ffion to your way

() Custom (advanced)

C Create a virtual machine with advanced
onngy Y options, such as a SCSI controller type,
Openy VMware virtual disk type and compatibility with | for VMware

. older VMware products.
Workstation 9

Virtug)
& ==n] &

A

Chon tiép Installer disc image file (iso). Browse dén file iso Ubuntu desktop 16.04 ubuntu-
16.04-desktop-i386.is0 -> Nhan Next

[T Vitware Workstorior T T T R =

File Edit View VM Tabs Help

polEl b od|Oan s o

Library x| 1 Home ]

| Q, Type hereto search

=l My Computer

= VMware” W et —

Guest Operating System Installation
A wirtual machine is like a physical computer; it needs an operating
system. How will you install the guest operating system?

Install from:
Creats
Create () Installer disc: \fration used by
) Pputer.

14 DD R Drive (G:)
Open|| U
Openg " [ficn to your way

(@) Installer disc image file (iso):

D:\Download wbuntu-15. 10-desktop-i336.is0 -
Connd)| ,_i‘J Ubuntu 15,10 detected.
Openy| This operating system will use Easy Install (What's this?) br Vilware

() I willinstall the operating system later.
The virtual machine will be created with a blank hard disk.

Virtud)
]I 1 od| e <mack | [het> | e ) I°°

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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Pién thong tin cho mdy 4o ( thong tin tiy timg ca nhan) ->Next

VMware W:

File Edit View VM Tabs Help
RS RERRORoRC I aI=R_NCNN=

Library x
{5 Home x]
| Q Type here to search - ‘

=l My Computer

£ Shared YMs VMwa re® W rMEw Virtual Machine Wizard

Easy Install Information
This is used to install Ubuntu.

m Personalize Linux
| Creatd

ﬁ? Create Full name: nvdong
S

User name:  nvdong

. Open|) Password: seesssss
Opendl|  confirm: ssensnnyl
| Connd)

[I Open | for ViMware
I"ill.l-l N
Create| | | Ware
I Back MNext

l! phyaic)| [ e ] S T ]l

Nhén Next va dién thong tin nhu bén dudi -> Next

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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Mew Virtual Machine Wizard S

Name the Virtual Machine
What name would you like to use for this virtual machine?

irtual machine name:

Ubuntu Desktop 16.04LTS

E:\1152TH124

The default lggltion can be changed at Edit > Preferences.

Thw muc sinh vién vira tao

< Back ][ Mext = ][ Cancel

Sau do6 chon thong tin nhu sau

r Y
Mew Virtual Machine Wizard ﬂ

Specify Disk Capacity
How large do you want this disk to be?

The wirtual machine's hard disk is stored as one or more files on the host
computer's physical disk. These file(s) start small and become larger as you
add applications, files, and data to your virtual machine.

-

Maximum disk size (GB): 20,0 =

1] Recommended size for Ubuntu: 20 GB

c:ﬂ Store virtual disk as a single file! ’

(7 split virtual disk into multiple files

Splitting the disk makes it easier to move the virtual machine to another
computer but may reduce performance with very large disks.

[ [ = Back ] [ Mext = ] [ Cancel ]
Nhan Next rdi Finish

Két thuc qua trinh khoi tao 1 may ao Ubuntu

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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% Buwoc 3: Khéi dong cai dat Ubuntu desktop 16.10 trén may ao vira tao

Néu mdy a0 Ubuntu chua bit dau khoi dong thi:
Chudt phai vao may do chon Power -> Power On
|3 Ubuntu - VMware Workstation T feconinlh ]
File Edit View VM Tabs Help
B | & | ® ¢ |0 = EH | (3
Library X

- Home [y Ubuntu
Q Type here to search v
o @l My Computer
Lp Ubuntu
) Shared VMs

ubuntu®

To direct input to this VM, click inside or press Ctrl+G.

Man hinh cai dat dau tién c6 dang sau:

) Ut -t Wokstaior ™ T

File Edit View VM Tabs Help
1> | & | B ¢ D= E & DO
Library x

Home (§ Ubuntu
Install (as superuser)

= =l My Computer
( Ubuntu

@ Shared VMs Help and support

The Official documentation covers many of
the most common areas about Ubuntu. It's
available both and via the Ubuntu Help
item in the System menu.

At you can ask questions and
search an impressive collection of already
answered questions. Support in your own
language may be provided by your

For pointers to other useful resources, please
visit
or

* Retrieving file 6 of 39 (1min 48s remaining)

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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Cho cho hé théng tu dong cai dat xong

s Buéc 4: Restart va khéi dong

Man hinh Ubuntu sau khi cai dat xong s& nhu sau:

Ubuntu Desktop 13 9) 957AM

B. Cac thanh phin co bén va cira s6 I¢nh

1. Cau triac thuw muc Ubuntu
Giao di¢n gan giong hé diéu hanh Windows

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS



Linux va phan mém ma nguon mo GV Nguyén Vin Bong — Khoa CNTT — BH
Thaiy loi

les
\ o iles
_thegeekstuff.com

—

2. Trung tam cai dit va quan ly cac phan mém - goi
Dé vao trung quan ly phan mém — g6i caa Ubuntu

Ubuntu ' Ubuntu So re 3 €) 10:06AM %

Ubuntu Software

Editor's Picks

€3 - v X

GParted GeoGebra Terminal LyX

o B = D |

-

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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3. Cira s6 l1énh Ubuntu

Dé mé cira s6 1énh cia Ubuntu : Chuét phai vao man hinh nén chon Open Terminal

Ubuntu Desktop Ty =) 10:01AM ¥

;ﬁ New Folder
=

: New Document

Open Terminal

Organize Desktop by Name
v Keep Aligned

i Change Desktop Background

-
=
=

Céch thir 2 14 dung t6 hop phim Alt+F2 dé mé cia s6 Run Application, gd vao “gnome-
terminal” va click Run.

® Ty =) 10:03AM ¥

&) - | ® gnome-terminal
& Results

o o

gnome-terminal gnome-terminal.real gnome-
terminal.wrapper

Cira 56 Iénh nhu sau:

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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Terminal Terminal File Edit WView Search Terminal Help Ty ) 10:04AmM F

rootk@ubuntu: ~

nvdong@ubuntu:~% sudo -i

[sude] password for nvdong:

root@ubuntu:~# 1s -1rt

total @

root@ubuntu:~# pwd

Jroot

root@ubuntu:~#

nvdong@ubunt f =

1ls: cannot op € ".": Permission denied
nvdong@ubuntu:, S

1s: cannot open directory '.': Permission denied
nvdong@ubuntu t$ logout

bash: logout: ot login shell: use “exit'
nvdong@ubuntu ootS$S exit

exit

root@ubuntu:~# W

A

=
s
=
S

Mot s6 Iénh co ban

- pwd: day la viét tat ctia chit “print working directory”, 1énh nay sé& in dia chi thu muc
ma ban dang ¢ trong d6 (thu muc hi€n hanh).

= Is: hién 1én man hinh nhirng tap tin va thu muc trong thu muc hién hanh.

= dir: tuong tu Is

- cd: thay d6i thu muc hién hanh
- cd dwong-din-dén-thu-muc: s& chuyén ban dén thu muc ma ban cung cap duong

dan, vi du cd /etc s& chuyén ban dén thu muc /etc.

- cd /: chuyén ban dén thu muc gdc ctia 6 cimg (con goi 1a thu muc root)
- cd hay cd ~: chuyén ban dén thu muc home cua ban
= cd.. chuyén ban dén thu muc cha cia thu muc hién hanh
= cd —: dua ban vé thu muc trude do

= Cp: day la 1énh copy, sao chép tap tin hay thu muc, vi du copy taptinl taptin2 sé tao
taptin2 la ban sao cua taptinl

= mv:di chuyén tap tin hay thu myc, con dung dé doi tén tap tin hay thu muc, vi du mv
taptin filesé d6i tén taptin thanh file, hay mv /home/tieuhau/Pictures
/home/tieuhau/Public s& chuyén thu muc Pictures trong /home/tieuhau vao thu muc
Public

= rm: x6a tép tin hay thu muc
= rm -r: x6a thu muc va tat ca tap tin va thu muc con trong thu muc do

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS



Linux va phan mém ma nguon mo GV Nguyén Van Pong — Khoa CNTT — PH
Thaiy loi

man: hién thi cach st dung 1énh nao do, vi du man cp s€ chi ban cach dung 1énh cp
clear: x6a man hinh terminal, hiru dung khi man hinh dﬁy, ban nén x6a tréng dé d& nhin
sudo cau-lénh: thyc hién cau 1énh v& quyén cua ngudi quan tri

= sudo -i: chuyén sang st dung tai khoan quan tri

apt-get install tén-wng-dung: cai dat (rng dung

apt-get remove tén-irng-dung: gd bo ung dung

apt-cache search tir-khda: tim kiém ung dung c6 tén gan gidng véi tir khéa ban cung
cap

cat: xem ndi dung tap tin, vi ducat ~/sodienthoai.txt s€ xem ndi dung tap
tinsodienthoai.txt

PHAN 2: CAI PAT VA LAM QUEN CENTOS

A. Cai diat CentOS

< Budc 1: Khéi dong phan mém may a0 VMware

- Sau khi khéi dong VMware nhu hinh sau

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS



Linux va phan mém ma nguon mo GV Nguyén Vin Bong — Khoa CNTT — BH
Thaiy loi

| File Edit View VM Tabs Help f
P2 o O)axg|o
Library X & Home X}

| Q, Type hereto search -

=l My Computer

2 s VMware” Workstation 9

| ] Create a New Virtual Machine Virtual Network Editor
'? Create a virtual machine on this computer, Change the network configuration used by
o - __ virtual machines on this computer.
|

) = Open a Virtual Machine e, = Workstation Preferences

RN —=

Open a virtual machine en this computer, A Custemize VMware Workstation to your way
- of working.

Connect to a Remote Server 7 . Software Updates

Open virtual machines on a remote server. | | Check for software updates for Vivware

\\ / Workstation.
Virtualize a Physical Machine 7 . Help
= (Create a virtual machine from an existing | | View the help topics for ViMware
physical machine. \\ / Workstation.

% Buwdc 2: Cai dat CentOS 7 15.11 trén may 40 VMware

Trén man hinh chinh VMware chon File ->New Virtual Machine Nhan Next

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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VMware Workstation —— - = GMLE.JM ‘

File Edit View VM Tabs Help
- ‘\/“:/\,\“E‘Ex g | O

Lib X
ey l (i Home |
=

{ Q_ Type here to search

=l My Computer

ared VMs & [ New Virtual Machine Wizard ==
Bt VMware™ W0 gume

Welcome to the New Virtual

“P L Machine Wizard
rea

Create

= Open
> ] Open
e
Create a virtual machine with advanced

j Conngj options, such as a SCSI controller type,
{ Openy VMware virtual disk type and compatibility with r VMware
-

. older VMware products.
Workstation 9

\fration used by
What type of configuration do you want? ‘Pputer.

@ Typical (recommended)

Create a Workstation 9.0 virtual machine
in a few easy steps. |[fion to your way

() Custom (advanced)

1 Virtudl
[Im o ] &

A

Chon tiép Installer disc image file (iso). Browse dén file iso CentOS-7-i386-DVD-
1511.is0 -> Nhan Next

===

[ VMware Workstation

File Edit View VM Tabs Help
B2 00 d||nexm|oO
Library

X =
=7 | {a Home X ‘ (B Ubuntu ‘
Q Type here to search M .

= 1MyCDmputer ® .
] VMware” Workstation 9

[k New Virtual Machine Wizard &1

Guest Operating System Installation

A virtual machine is like a physical computer; it needs an operating
system. How will you install the guest operating system?

Install from:
W [ itor
y © Installer disc: iguration used by
L c . is computer.
4 DVD RW Drive (G:) v

\frences
= to your way
| © Installer disc image file (iso):

F:Wew folder\CentOS-7-x86_64-DVD-1511_2.iso

4\ Could not detect which operating system is in this disc image. f
3 ) You will need to specify which operating system will be installed. Ferosmu
/‘ © Iwilinstall the operating system later.

The virtual machine will be created with a blank hard disk.

[I:* [ <Back ) [ mext> | [ cancel ] ||ffor VMware

Chon thong tin cho may 4o
- CentOS
- Linux

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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F N
Mew Virtual Machine Wizard g

Select a Guest Operating System
Which operating system will be installed on this virtual machine?

Guest operating system

(") Microsoft Windows
@) Linux

(71 Novell NetWare
| © sun solaris
il ) vMware ESX i

() Other

\ersion

Cent0s5s -

[ <Back ] [CNext> [ concel

Nhéin Next

o Y
Mew Virtual Machine Wizard u

HName the Virtual Machine
What name would you like to use for this virtual machine?

Virtual machine name:
CentO5s 7 15.11

[ E:\11TH1521325| Browse...

The default location can be changed at Edit = Preferences.

Thw muc sinh vién tao !

-

tai 0 SINHVIEN

[ < Back ] [ Mext = ] [ Cancel ]

Nhéan Next

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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Mew Virtual Machine Wizard lﬂhl

Specify Disk Capacity
How large do you want this disk to be?

The wirtual machine's hard disk is stored as one or more files on the host
computer's physical disk. These file(s) start small and become larger as you
add applications, files, and data to your virtual machine.

Maximum disk size (GEB): 20.0

Recommended size for Ubuntu: 20 GB

Split virtual disk into multiple files

Splitting the disk makes it easier to move the wvirtual machine to another
computer but may reduce performance with very large disks.

Help | <Back || mMext= || cancel |

Nhan Next roi Finish
Két thuc qua trinh khoi tao 1 may ao CentOS
s Buwéce 3: Khéi dong cai dat CentOS trén may 4o vira tao

Néu médy ao CentOS chua bt dau khoi dong thi:
Chuot phai vao may do chon Power -> Power On

Cent0s 7

Install CentOS 7
Test this media & install CentDS 7

Troubleshoot ing

Automatic boot in 43 seconds...

Nhén Enter chon Install CentOS 7
Sau d6 nhan vao cac thong tin Setting va chon cac setting twong trng sau d6 chon Done

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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INSTALLATION SUMMARY CENTOSLINUX 7 INSTALLATION
EA us Help!

SECURITY POLICY
Everything okay

INSTALLATION SOURCE SOFTWARE SELECTION
Local media Minimal Install

INSTALLATION DESTINATION KDUMP
Automatic partitioning selected Kdump is enabled

NETWORK & HOST NAME
No network devices available

Begin Installation

L' Please complete items marked with this icon betore continuing to the next step.

Muc Software Selection lua chon : Minimal Install

CONFIGURATION CENTOS 7 INSTALLATIO

ER us Help!

(=Sl )SER SETTINGS

ROOT PASSWORD . USER CREATION
Root password is not set m No user will be created

< Creating lvmpv on /dev/sda2

--------------- [S<R—]

CentOS Virtualization SIG : N —
Virtualization in CentOS, virtualization of CentOS = = BT T‘
wiki.centos.org/SpecialinterestGroup. — mim ===
ETTTTT eZeTeIelsleleleleleel

ii. Please complete items marked with this icon before continuing to the next step.

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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Pién céc thong tin cho cac muc nhu KEYBOARD, TIMEZONE, ROOT PASSWORD,
USER CREATION,...
Sau d6 nhan BEGIN INSTALLATION

B. GIAO DIEN CO BAN CENTOS

entDS Linux ? (AltArch)
[Kernel 3.18.8-327.e17.i686 on an i686

Last login: Sat Apr 23 18:83:42 on ttyl

[root@localhost ~1# _

Thue hi¢n mét s6 1énh co ban:

-su [tén username] : Chuyén sang username khac
-sudo —i: Chuyén sang user root

-hostname: Xem tén may ao

-date: Xem ngay gio hé théng

-pwd: Xem thu muc hién tai

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS
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entDS Linux ? (AltArch)
[Kernel 3.18.8-327.e17.i686 on an i686

Last login: Sat Apr 23 18:83:42 on ttyl
[root@localhost ~1# time

jreal B . 6808s
LSer Bmd .BBAs
fsys Bmd .AABs
[rootPlocalhost ~14# uptime

11:49:13 up 4 min, 1 user, load average: B.83, B.11, 8.85
[rootPlocalhost “1# hostname

localhost.localdomain

[rootBlocalhost ~1# pud

raot

[rootPlocalhost ~1# su nwdong

[nwdong@localhost rootl§ -

BAI TAP VE NHA:
Bai 1: Tim hiéu va cai dat gd chit tiéng viét trong Ubuntu. (Bang giao dién va dong lénh)

Bai 2: Thuc hién tao, di chuyén, doi tén, x6a, dém téng s6 file trong mot thu myc trong
CentOS (thuc hién bang dong 1énh)

Bai thuc hanh 1: Cai dat, lam quen Ubuntu va CentOS



